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Learning Outcomes
By the end of this unit the learner will be able to:

 Recognize the importance of minute-taking and understand how OneNote can make the process
more efficient, organized, and reliable.

 Develop key minute-taking skills, including listening skills, critical thinking, and organization and be
able to apply these during and after meetings to produce excellent meeting minutes with OneNote
and other tools.

 Be able to remedy many of the complaints that beset Minute-Takers both through best practices
and through use of the OneNote software.

 Be able to write minutes that are suitable for formal meetings, semi-formal meetings, and action
minutes using the templates provided in the example Minute-Taker notebook (or their own
customized templates).

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Unit 7

Minute Taking

The Role of a Minute-Taker

What is a Minute-Taker?

Being a Minute-Taker can:
 Give you access to other members of the group.
 Keep you up to date on what is going on in the organization.
 Enable you to help the chair accomplish the goals of the organization.
 Keep you more focused on what is being said, so your comments are relevant and your interpretation of

what happened is accurate.

Sometimes we feel like accepting the role of Minute-Taker in a meeting has just relegated us to the back seat,
and in a boring role. In actuality, the Minute-Taker plays a vital role within the meeting and can choose to use his
or her responsibilities wisely (or not). Keep in mind that minutes are legal documents so you must take extra care
to be as accurate as possible. The Minute-Taker has legitimate, easy access to other members of the meeting,
including those in key positions.

However, there are still people who avoid taking minutes if at all possible and who are intimidated by the idea of
taking minutes because they are unsure of how to do this, and fearful of missing important details. But with
Microsoft OneNote it is easier than ever to make sure you don’t miss a beat during the meeting.

OneNote 2007 (a part of the Office 2007 suite of programs) is a very useful tool you can use to help you with your
minute-taking duties. It makes it possible to take notes as fast as one can write in a conventional notebook, but
the immediate result is well-formatted, searchable, and easily shareable without transcribing. OneNote also has
the ability to record audio directly into the notebook, ensuring that the Minute-Taker has the information correct
every time. OneNote also seamlessly integrates with Microsoft Outlook and Word so it is very easy to distribute,
print, and archive meeting minutes.

Using OneNote is very similar to using Microsoft Word except you can write a note anywhere, just like a paper
notebook. Also, you can manage pages and sections like a paper notebook except you also have the ability to link
pages and sections, other documents, add images, and search the document easily. OneNote combines the ease
of taking notes in a paper notebook with the ease of searching, organizing, and editing notes in a Microsoft Word
document.

In many meetings, the chair may act as recorder but this is not recommended because it prevents the chair from
devoting his/her full attention to the discussion and may result in incomplete minutes. The same holds true to a
lesser extent for meeting participants so many organizations will use a dedicated Minute-Taker at their meeting.
This position may also be called: recording secretary, secretary, note taker, recorder, or another appropriate
name. Regardless of what other roles the Minute-Taker has in the meeting or what the Minute-Taker is called,
OneNote can help them.
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According to Robert’s Rules of Order, if the chair is absent and there is no vice-chair, the
secretary should call the meeting to order and preside over it until the meeting elects a chair pro tem (for the
time being).

Minutes should be written to provide all the members with the following information:
 How issues were discussed and finally resolved.
 The names of those individuals who were assigned specific tasks and the dates these tasks are to be

completed.
 Minutes are considered legal documents.
 Motions should be recorded word for word.

Because of the level of detail you will be required to record, using a digital voice recorder or the audio recording
functionality included with OneNote gives you piece of mind if you fall behind the flow of the meeting. Your
recording will be there as a backup.

What is the purpose of minutes?
 A clear summary of proceedings, a means of conveying information, a reminder for future actions and a

historical background on decisions of the group.

What is your role as the Minute-Taker?

What are the tasks you are expected to perform?

What are some of the common problems you or others have experienced as a Minute-Taker?

If you were asked to record the minutes for a meeting, what equipment and information do you
need to know? (Think of as many things as you can.)
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Problems and Solutions

Here are some problems that a minute-taker might encounter. What solutions can you think of for the following
problems?

A weak chair who can’t keep participants on track.

Speakers who mumble, ramble, or speak too fast.

Speakers who are disorganized.

Chairs and speakers who give vague directions.

Speakers who ask the Minute-Taker to create motions around their comments.

Too many people talking at once.

Distractions.
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Not following the agenda.

An impossibly long agenda.

Motions made at top speed.

Speakers not identifying themselves.

Negative people.

Power hungry people.

Unprepared members.

Not being allowed to have a break when members have one.
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Being sent out of the meeting to make coffee or photocopies.

Can you think of any other problems?

The Skills of a Minute-Taker

Key Skills

To function properly as a Minute-Taker, you must also be alert, highly organized, and focused on the group
discussion, in order to restate the positions and the discussions of others accurately and objectively. Not
everyone is suited to this job.

A Minute-Taker must be:
 A good listener
 A sound critical thinker
 An excellent organizer

Appearances count for 55% of others’ impression of you. This includes your body language as well as your
clothes. Here are some tips to help you convey confidence about yourself and your abilities:

 Learn to develop a poker face during the meeting itself, so as to show no emotion about motions or
member comments. Remember, your job is to be impartial and record the events of the meeting.

 Learn to relax and enjoy your role.
 Dress like everyone else in the group but stay on the conservative side.
 Greet members as they come in and say a cheerful goodbye when the meeting is over.
 Always shake hands, as it is the universal opening ritual of any business transaction. Your grip should be

firm but not overpowering, and remember to make eye contact.

Are there any other things you can recommend to help improve your confidence?

Listening Skills (A Good Listener)

Research has shown that you spend most of your day communicating. Of that communication time, half is spent
listening. Research also shows that you only understand 50 percent of what you hear, and that your active
forgetting process removes much of that within a day. This lack of understanding is extremely costly.
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The cost of not listening is staggering, but the truth is, we can all learn to listen better, if we follow some key
guidelines.

A successful Minute-Taker should always have a backup: a primary minute-taking method, such as OneNote, that
includes partial or full audio backup is highly recommended. We don’t always hear as much as we would like to
think! After all, the recording of specific details is what makes useful, accurate minutes.

An audio recording can be made using the built in recording functionally of OneNote or by using a specialized
digital recorder. While not all organizations will want to use audio recording tools, those that do will find that
they are perfect for creating an invaluable archive of resource material. Digital audio recordings are very easy to
reproduce and will benefit both the Minute-Taker and for anyone in the organization who could not attend the
meeting.

Listening for Answers
The ability to really listen is an important skill for anyone to have. Listening allows you to understand where the
other person is coming from, and shows you’re interested in what he/she has to say.

Unfortunately, we all experience common listening problems.
 We let our attention wander.
 We miss the real point.
 We let our emotions interfere.
 We step on the statements of others.
 We think ahead and miss what’s being said right now.

To improve your listening skills, use the three steps of active listening.
 Non-verbal messages: Eye contact, an alert expression, head nodding, and a forward lean to the body

expresses listening.
 Cues or invitations: These are the phrases like “uh-huh, O.K., Yes, go on, etc. that signal our attention

and invite an individual to continue talking.
 Clarification of what has been said: We can do this in one of several ways: by asking questions,

summarizing what has been said, or paraphrasing the message in your own words.

There are a number of articles on the Internet that talk about “proper protocol” for using laptops and recording
equipment during a meeting. In order to maintain civility, participants should be as unobtrusive and courteous as
possible. No one wants to be in a meeting where someone clatters away on their keyboard. But what about the
Minute-Taker?

If you are the Minute-Taker you are expected to make a bit of noise; to assume you will remain silent is not being
respectful of the job you are assigned to do. We recommend you try using one of those squishy roll-up
keyboards, which are inexpensive and available from most computer retailers.  They do take a bit of getting used
to, but if you practice you can actually hit the keys quite hard and barely make a sound. They are also easy to
keep clean as they are waterproof right up their plug: just wash them carefully in the sink!
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Some people can type faster than they can write, unless they are fluent with their own shorthand. Also, many
organizations make use of a meeting template. If you are responsible for recording minutes, using template will
save you a lot of time. We will discuss using written and OneNote templates later on. We have also included a
number of OneNote notebooks with this course that make use of these templates.

Critical Thinking (A Sound Critical Thinker)

To take accurate minutes, you must be able to think critically and quickly. Minutes should be a record of the facts
of the meeting; they must not be tainted by biases or judgments.

We could spend a whole day talking about critical thinking, but the basics are similar to Edward DeBono’s white
hat thinking.

Imagine a computer that gives or records the facts and figures for which it is asked. The computer is neutral and
objective. It does not offer interpretations or opinions. When wearing the white thinking hat, the thinker imitates
a computer.

The person requesting the information should use focusing questions in order to obtain information or
information gaps.

In practice there is a two-tiered system of information. The first tier contains checked and proven facts: first-class
facts. The second tier contains facts that are believed to be true, but have not yet been fully checked: second-
class facts.

There is a spectrum of likelihood ranging from always true to never true. In between, there are usable levels such
as by and large, sometimes, and occasional. Information of this sort can be put out under the white hat, provided
the appropriate frame is used to indicate the likelihood.

White hat thinking provides discipline and direction. The thinker strives to be more neutral and more objective in
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the presentation of information.

The white (absence of color) also indicates neutrality.

Organization Skills (An Excellent Organizer)

There are many different ways to organize your minute notes. Whatever method you choose, it must work for
you, and it must be consistent and help you create accurate notes.

One method is to develop a template beforehand, depending on the style of the meeting and the minutes you
will be preparing. We will look at some different styles later on this morning, but here’s a sample template. (You
would, of course, need more white space than is provided here – this is just a sample.)

As you can see, the templates are very basic and to the point. All you need is the facts!

Meeting Date Meeting Location

Attendees Regrets

Topics Discussed

Decisions Reached

Action Items

Another method is to color-code your notes, or to use the margins of a page to note what part of the meeting
you’re recording.

Typing notes during the meeting will save you a lot of time later, and it will make organizing things a snap.
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Meeting Agreements

Meeting agreements or guidelines can make a Minute-Taker’s job much easier, particularly if the chair or several
members of the meeting team are new and not aware of their responsibilities within the group. The forms are
similar to a contract in that each player or member has the opportunity to see, in print, what is expected of him
or her, and by signing it, agrees to carry out certain tasks. The agreements included here are designed as basic
forms that can be easily customized to meet the specific needs of your organization.

The Chair
To ensure that the ABC Committee conducts its business in an efficient manner, I,
_________, the chair of the committee, hereby promise to do the following:

 Give all meeting participants adequate warning of an upcoming meeting.
 Prepare a detailed agenda.
 Allow all sides of an argument to be heard.
 Encourage all members to participate in a discussion.
 Restate all motions before a vote is taken and then state the outcome.
 Insist that complicated motions and resolutions be submitted in writing.
 Avoid sending the Minute-Taker out of the room during the meeting to run

errands.
 Permit the Minute-Taker to take a break when the group does.
 Be familiar with the parliamentary procedures used to govern the assembly.

_________________________________________
Chair
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The Recording Secretary
To ensure that the ABC Committee conducts its business in an efficient manner, I,
_____________, the recording secretary, hereby promise to do the following:

 Notify the chair of any unfinished business, motions, or reports that are due
at the upcoming meeting.

 Send out all agendas and accompanying material promptly.
 Make arrangements for any necessary equipment or refreshments.
 Arrive at the meeting at least 20 minutes early.
 Be prepared and organized and have any required photocopying completed.
 Alert the chair when a quorum is present.
 Provide the organization with objective, accurate minutes.
 Be familiar with the parliamentary procedures used to govern the assembly.

__________________________________________
Recording Secretary

The Meeting Participant

To ensure that the ABC Committee conducts its business in an efficient manner, I,
________________, hereby promise to do the following:

 Read the agenda and all accompanying material, including the previous
minutes, before the meeting.

 Bring all necessary reports and information to the meeting.
 Be prepared to discuss the items on the agenda.
 Avoid emotional and tactless remarks.
 Address all remarks through the chair.
 Put all complicated motions and resolutions in writing.
 Listen to the remarks of others with an open mind.
 Give everyone an equal chance to speak.
 Avoid asking the recording secretary to run errands for me during the

meeting.
 Be familiar with the parliamentary procedures used to govern the assembly.

___________________________________
Meeting Participant
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Minutes Styles

Choosing a Style

Minutes are a permanent, formal record of what went on in a meeting. Their purpose is to provide members of a
group with:

 A clear, objective summary of the group’s activities.
 A means of conveying information to people unable to attend the meeting.
 A reminder of future expected actions.
 A historical background of the decisions of the group and the rationale behind them.

When approved, minutes are considered legal documents and can be used in legal proceedings.

Minutes may be written in a variety of styles, including formal, informal, or action. The choice of style is based on
the nature of the meetings and the bylaws of the members themselves.

Formal minutes support a meeting which is governed by a chair according to a parliamentary code or procedure.
There are a number of reference guides to parliamentary procedure, such as Robert’s Rules of Order or
Procedures for Meetings and Organizations.

Semiformal or action minutes are used by small groups who do not have a clearly defined operating structure.

Minutes don’t have to be verbatim to be proper, with the exception of motions, which should be recorded word
for word. Word for word documents are too time-consuming to prepare and to read. However, groups differ as
to how much detail they require. Some groups want minutes to be an outline of everything that was discussed so
they have justification for decisions. Others feel that background information is not essential, providing members
understand the remarks. It is important that you, as Minute-Taker, know what type of minutes the group expects
to receive and can deliver them consistently.

For example, a committee concerned with public hearings relating to changes in municipal bylaws can correctly
choose one of two styles:

 Comprehensive minutes with a detailed rationale for every decision.
 Minutes that are concise, with the rationale “passed in accordance with Section 345 of the Zoning

Bylaw.”

Informal Minutes

Small groups, perhaps because of their size, sometimes prefer to operate more informally. However, minutes are
still a vital component of the meetings and can be prepared as described. Informal minutes support meetings
that operate on a modified version of parliamentary procedure. They report what occurred at the meeting for the
people who were absent, and for future reference. They summarize the action taken, the action planned, the
people responsible, and the deadlines.

Informal minutes are written in a narrative format in complete sentences. They include some background
information, keeping in mind they are written solely for the benefit of people already familiar with the group and
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its activities.

Action Minutes

Action minutes are best suited for meetings that operate in a purely conversational manner. They can be written
in point form. You need to identify the person or people responsible for future actions and set time limits.

In many informal meetings the Minute-Taker is encouraged to participate in discussions, or the chair may also act
as Minute-Taker. In some groups, members share the responsibility of Minute-Taker with a different person
appointed for this task at each meeting. In such situations, action minutes are usually easiest to use. They allow
you to make notes as well as participate, and the straightforward format keeps the minutes consistent despite
the different people involved.

Formal Minutes

In formal meetings, decisions are reached through motions. Motions are proposals placed before the members
for debate and voting. These must be recorded verbatim.

When you are organizing the minutes of a formal meeting, they follow the same organizational pattern as the
steps in a formal meeting.

Heading
The heading should be one inch from the top of the page. Each heading line should be centered and typed in the
style preferred by the organization (either capitals or uppercase/lowercase letters).

The heading should include the word “Minutes” and the name of the group or committee holding the meeting.

Introductory Paragraph
There is no rule about which line should come first, but be consistent. Use the same style for all of an
organization’s minutes and agendas. The place, time and date of the meeting can be in the heading or in the
introductory paragraph. (If the place of the meeting is always the same, it may be omitted.)

The minutes should also state whether the meeting is a regular (weekly, monthly, yearly) or special meeting.

Attendance
Include the names of those who attended as well as the names of those invited who did not attend. These can be
listed casually or in alphabetical order. List people who are not regular members as “In Attendance.” You should
also record who chaired the meeting, as well as your name as the recording secretary/note taker.

Minutes of Previous Meeting
At the beginning of the meeting, the chair asks the members to approve or amend the minutes of the last
meeting. You can record this decision as a motion. However, it is preferable to use one of the following standard
forms:
Minutes of the June 10, 2020 meeting were approved as read.
Minutes of the June 10, 2020 meeting were approved as circulated.
Minutes of the June 10, 2020 meeting were approved with corrections.
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The reading of the minutes of the June 10, 2020 meeting was deferred until…

Reports
This includes any reports received from any of the groups’ officers or committees. As Minute-Taker, you must
summarize any reports or other documents presented at the meeting and then either attach them to the minutes
as an appendix or refer to them in the minutes as “filed.”

If a report was sent to the group for information purposes only, indicate the report was “received.”

If a report was presented orally, or accompanied the report with a verbal explanation, indicate the report was
“presented.”

If the report contains a statement of opinion and facts, and concludes with resolutions, then you should record
the report was “adopted” or “accepted.” A report could also be “considered” if the group wants to look at it
further.

When the group decides to “adopt” a committee’s resolutions, enter the resolution in full into the minutes. With
a particularly important report, the group may order it “to be entered into the minutes.” In that case you must
include the whole report in the minutes.

After someone moves either to accept or to adopt a report, the report is then open to amendment by the group.

Finances
Finances are usually discussed under the treasurer’s report. No action is required for this type of report. In fact, it
is technically improper to approve the treasurer’s report unless it has been audited. A treasurer’s annual report is
different. It will be in written form and should be audited. Then a motion and a vote are required on accepting
the auditor’s report.

Correspondence
Letters, faxes, and e-mails sent to the group are usually read by the secretary and either filed or attached to the
appendix of the minutes. Telephone conversations may also be handled in this way.

Unfinished Business or Business Arising from Previous Meeting
This involves motions or issues brought up at earlier meetings and deferred to the current meeting, details of
follow-up, and new actions as a result of previously handled business.

New Business
This portion of the meeting is devoted to the introduction of new information. It may also include handing
specific tasks to specific members of the group and setting deadlines.

Adjournment
The chair may call for a motion to adjourn or may adjourn the meeting himself or herself after ascertaining there
is no further business.

As Minute-Taker, you would record:
 The chair adjourned the meeting at 2:30 p.m.
 There being no further business, the meeting was adjourned at 2:30 p.m.
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Next Meeting
Record the date, time, and location of the next meeting.

Signatures
Highly formal groups still prefer, “Respectfully submitted,” before any signatures, although this is usually omitted.
However, the Minute-Taker’s signature and title should appear at the end of the minutes. The Minute-Taker may
also choose to include the date when the final preparation of the minutes was completed. This is optional.

In formal minutes, the chair initials all pages of the minutes and signs the last page to prevent any alterations.

What Do I Record?

Recording Motions and Resolutions

Motions
In formal style minute-taking, all properly made motions must be included in the minutes. (Generally, to be
proper, a motion must be moved and seconded.) Committee meetings are less formal and motions made there
do not need to be seconded.

It is standard practice that a motion begin with the word, “That,” followed by a noun and a verb, and that each
motion be formed as a positive statement.

The minutes should state who made the motion and whether it was carried, defeated, or tabled (i.e. postponed).
The reason for recording defeated motions is that the issue can only be raised again under special conditions.

Very formal minutes also include the name of whomever seconded the motion, and if the issue is contentious,
the names of those present and the side they voted on. If the vote is by secret ballot, the minutes contain the
number of votes for each side.

Sample Motions
Here are some simple motions.

 MOTION: It was MOVED, SECONDED, AND CARRIED, “That the Board support the production of an
educational brochure on drug and alcohol addiction.”

 MOTION: It was MOVED by Jennifer Becevello and SECONDED that the unit hires three additional
salespeople. MOTION DEFEATED.

 Dr. Jeff Chin made a motion that Dr. Timothy Luke be granted staff privileges. Dr. Peter Thomas seconded
the motion, which was passed unanimously.

 Mrs. Georgina Dodds proposed that the Information Services Branch donate $1,000 to the Save the
Children Campaign. Motion passed by general consent.

 Mr. Roy Sconci moved, seconded by Ms. Eileen Hall, that the SK Management Company takes over the
operation of the Rosevale Nursing Home. Motion defeated.

 Motion No. 9X-34, moved by Cameron Ward, seconded by Paul Becevello. Moved, that the Board appoint
the YMCA to be the operator of the child care facility opening at Queen and Main Streets in September
2020. This operator would also be responsible for the before school, lunch, and after school programs on
the premises. Motion No. 9X-34 Carried.
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Here is an example of a series of motions:
 It was moved that we hold a picnic.
 It was moved in amendment by Ms. Nancy Beeker, seconded by Mrs. Joan Smith: That we hold a picnic

and a dance.
 The chair declared the amending motion lost. The question was then put to the main motion; it was

resolved in the affirmative.

Explanation: Someone on the committee moved that the group hold a picnic. Ms. Nancy Beeker amended the
motion in include a dance in addition to the picnic. The chair then asked the assembly to vote on Ms. Beeker’s
amendment. The group voted not to have both a picnic and a dance. The chair declared the amending motion
(Ms. Beeker’s) lost and then called for a vote on the main motion – to hold just a picnic. The assembly voted yes:
they want a picnic.

Here is another example of a series of motions:
It was moved by Ms. Karen Giles that an ad hoc committee for community relations be established. It was moved
in amendment by Mr. Adrian Chin that an ad hoc committee for community relations, composed of three
Canadian citizens, be established. Amending motion and main motion carried.

Explanation: In this case, Karen Giles moved that an ad hoc committee for community relations be established.
Adrian Chin amended the original motion to include the fact that the committee be composed of three Canadian
citizens and the group voted in favor of this. The chair then had to ask the group to vote on the main motion –
the establishment of the ad hoc committee. The result of the vote showed that, yes, the group agreed to the
committee.

Resolutions
A resolution is a written motion phrased in a special style, with “whereas” followed by resolving clauses (what the
group plans to do about it). You must include in the minutes a full description of any resolutions that were
adopted and a simple statement of any that were rejected.

Resolutions are often lengthy so encourage people to write out their resolution before it is given to you to record
in the minutes.

When typing a resolution follow these guidelines:
 Indent all lines 15 spaces.
 Type both “WHEREAS” and “BE IT RESOLVED” in capital letters.
 Single space between the lines and double space between sections.
 Use capital letters and bold type if a person’s name is included.
 Any reference to money should be written out, followed by the numerals in parentheses. For example,

“two hundred dollars ($200).”
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Sample Resolution

The Cobden City Council moved the adoption of the following resolution:

WHEREAS, for a number of years MARGARET BOUDREAU has served as president of the local Cancer
Society,

and,

WHEREAS, she has chaired this city’s Literary Guild for two years;

and

WHEREAS, she has been highly involved in the establishment and operation of our food bank, therefore,

BE IT RESOLVED, that MARGARET BOUDREAU be named “Citizen of the Year,” and,

BE IT RESOLVED, that a donation of two hundred dollars ($200) be made in her name to the Cancer
Society, and,

BE IT FURTHER RESOLVED, that a banquet be held in her honor on Tuesday, the 22nd day of May, 2020.

What to Record

Whether you use shorthand, longhand, or a computer, remember that only the motions and resolutions are
taken down verbatim. (It is a wise idea to ask the members to put all complicated motions in writing.) The rest of
the minutes are an objective summation of what actually occurred.

Pay close attention to the discussion. You will find it helpful if you know why a topic is being discussed. Is the
group's purpose simply to obtain information, or is its aim to eventually reach a decision? If the latter is the case,
your notes should be progressive. If the purpose is to solve a controversial problem, you should have a number of
pros and cons recorded. Never inject your own personal bias or give one person's comments more weight than
another's.

Here are some guidelines.

Record:
 All pros and cons
 New information
 All motions (passed and defeated)
 Results of motions
 Expected action

Do not record:
 Speaker’s experience
 Old material
 Redundant information
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 Personal comments
 He said/she said information

Check with your organization to see if you should record withdrawn motions, as practice can differ.

Recording Information with OneNote

If you use OneNote in other areas of your job you are probably already familiar with the many ways you can flow
information into it. For those that are not as familiar, we will introduce some ways in which you can record
information in OneNote. Even if all of your students feel reasonably proficient with OneNote, you should still skim
over this section as a refresher.

When creating basic notes during the meeting, you may just want a blank page for you to brainstorm ideas or
create a note without any guidance or instructions. You also might want to use the area below the provided
Minutes templates in the provided notebook.

If you us the provided notebook when you add a new page in a Meeting Minutes section, the new page will use
the template for that section (Meeting Minutes).

If you are not using a Meeting Minutes section, a blank page will be created unless you have designated a default
template for that section (see section on templates).

To create a blank page in a section that has a designated template click the arrow on the new page button (see
below) and select “Blank Template” from the list.

We will start this section by showing you how to insert new pages and add text to those pages.

Creating a Page

You can add new pages to any section in your notebook. A page can be created using the New task pane or by
clicking New Page above the page tabs. For this concept we are going to use the New task pane.

To open the New task pane, click Explain Choices on This Menu from either the New sub-menu
in the File menu or the New button on the standard toolbar:



Office Administration / Office Skills

24| 2 4

This pane will list different types of content for you to create. Click on “New page” to create a page in the
current section:

The page inserted will always either use the default template for that section (e.g. a Meeting Minutes template)
or use a blank template. If it is a blank template it will be labeled Untitled until you enter the title of the page in
the title placeholder. (Your cursor will be placed here when you click New Page.) The title of the current page will
be shown in the title bar:

Creating Advanced Notes
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OneNote 2007 has a multitude of ways for you to collect and organize data. You can send web pages to OneNote,
gather screenshots from web sites, insert audio files, and add pictures.

This functionality will be most useful to you after the meeting when you are flowing in documents tabled during
the meeting (including images and other media that might have been used by meeting participants). Often there
will not be enough time to include these things in your notes during the meeting but if you make a note to
yourself, you can do so when preparing the formal Meeting Minutes.

Adding an Audio/Video Recording

With OneNote you can add audio files to your page as part of your notes. To record an audio file you need a
microphone or other recording device. As a Minute-Taker you might want to record the entire meeting or just
important parts of it like motions or resolutions that would be best noted down literally.

Although audio recordings are an excellent tool, you should be aware of several potential pitfalls before using
audio recording:

Get the permission of the group prior to doing any audio recording and notify everyone clearly when audio
recording begins and ends. If audio recording continues for long periods of time people often forget they are
being recorded and speak in ways which make it easy for their words to be taken out of context or say things that
they believed were spoken in confidence.

Always provide a visual reminder that recording is in progress (for example a large, red paper that says “ON AIR”
could be placed in the middle of the table whenever recording is taking place and removed when the recording is
paused or completed).

Your laptop microphone may not be sufficient for audio recording for a meeting room environment so you will
likely need an external microphone to effectively record meetings. Test this equipment thoroughly before using it
in a meeting and ensure you are completely familiar with its operation. Technical issues with recording
equipment should not hinder the flow of the meeting.

(Like screen clippings, you can insert audio recordings from the Insert menu, Standard toolbar, or the notification
area icon.)

Once you click Insert Audio Recording, OneNote will start recording. You will also see a toolbar of
audio and video recording commands:

When you stop recording OneNote will create the audio file for you and place it on the page automatically. It also
records the date and time, and the cursor is inserted below the file to let you type additional information:
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While you are recording audio or reviewing a recorded audio or video recording, whenever you take notes they
will be flagged with the time they were taken relative to the recording. This is indicated by a small “play button”
next to the note and shown when you hover your cursor over the note. If you click this play button the recording
will begin a few seconds before the note was taken and continue playing.

This functionality makes it very easy to record sections of the meeting and take detailed notes on them after the
meeting has ended. This technique is especially recommended for the following circumstances:

 You are a meeting participant and the designated Minute-Taker. You might want to record the meeting
and take detailed minutes notes later by reviewing the recording so that you can participate more fully in
the meeting.

 The meeting deals with technical areas you are unfamiliar with. By recording technical terms you can
review them later to make sure you have correctly noted them down (this is especially important for
motions, resolutions, and action items using these terms).

 A complex point was made and you want to ensure you correctly recorded it. Due to the nature of a
discussion, some points may be made which are difficult for a lay person to follow (aside from the
terminology used). If you can ask the speaker to enter then point (or motion, or action item) into the
meeting record directly by recording them saying it you can transcribe it literally later. This will slow the
meeting down less than asking them to make the point to you so you can take it down literally during the
meeting.

The video recording command is also found in the Insert menu or Standard toolbar. From here, it’s the same
process as recording audio: the toolbar will appear, you can record your video, and OneNote automatically
embeds it into the note. It also notes the time and date that the video was made.
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Like audio recording, you will almost certainly require special video recording equipment (e.g. external camera
connected to your PC, and audio equipment) and should follow the exact same procedures as for audio
recording. Video recording has an even greater chance of providing unintended footage so please be especially
careful you notify everyone they are on camera!
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Adding Pictures

Adding pictures to OneNote can be done from a file, a scanner, or a camera. Click Insert Pictures and
then select the input source:

When adding pictures from file folders, the browse dialog box will open for you to locate and insert your picture.
When inserting pictures from a scanner or a camera, OneNote will ask you to select the device listed, and then
will guide you through copying pictures from that device.

Adding Files

With OneNote you can embed virtually any file. From the Insert menu, click Files. The File dialog box will open for
you to add a file or a set of files to insert into a note/page. If any documents were tabled before or during the
meeting or are needed to understand the meeting minutes, these could be added directly to the meeting
minutes.
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Click Insert Files, select the file or file set to embed, and then click Insert.

Simply double-click the file to open and view it:

Organizing Data During the Meeting

During the meeting you can use OneNote’s various list making and outlining features to easily organize
information as you are noting it down. This is especially valuable in indicating each separate decision as it is
made, etc. OneNote can organize information bullets and numbers, creating lists, using outlining levels, and
customizing tagged notes.

Using Bullets and Numbers

Bullets and numbering can come in handy when organizing notes and lists. You can select text and click one of
these commands to apply bullets or numbering, or you can turn the feature on and then type. When taking notes
during a meeting you will want to use bullets and numbers to keep track of individual points as they are made,
separating action items, etc.

You can start a bulleted list or numbered list using the Formatting toolbar or using keyboard shortcuts:
 To create a bulleted list type an “*” and hit tab. As you press Enter, a new bullet item will

be added to the list
 To create a numbered list type “1.” and hit tab. Like the bulleted list, every time you press

Enter, a new numbered item will be added to the list.
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If you click the Bullets or Numbering button on the Formatting toolbar, the default bullets or numbers will be
applied to your text.

You can click the drop-down arrow next to the bullet button or the number button to choose a different bullet
style:
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If you click the Bullets command or the Numbering command from the Format menu (or click the More command
from the toolbar menu), you will see the appropriate task pane.

Bullets Numbers
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Creating Lists

To start a bullet or numbered list, click on the bullet or number style, type the comment or note,
and then press Enter. This will automatically enter a new bullet for you to continue the list:

Bullet and numbered lists can also be customized. By clicking the bullet or number you can increase the size,
apply color, or use the List command under the Format menu to apply horizontal and vertical spacing:
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Using Levels

Levels are used to organize bulleted and numbered lists after they have been created. With Levels you can hide,
or show the different levels in a list. To access a bullet or number level menu, right click at the border of the text
in the list, and choose to hide or select levels.

You can indent (or change the level) of a bullet or numbered list item using the keyboard by
pressing Alt+Shift and Left to “outdent” and Right to indent further. You can move a list item up
or down in a list by pressing Alt+Shift and up or down.

Customizing Tags

OneNote lets you apply default tags or custom tags to lists in order to remind you of events, phone calls, to do
items, and more. In some cases there may be an object you want to tag, but do not have a tag for. To create
your own tag, click the Tag button on the Standard toolbar and click Customize My Tags. When
recording meeting minutes you might want to use these tags to designate motions, resolutions, action items, or
tasks you (as a Minute-Taker) need to perform once the meeting is over and you are formalizing the meeting
minutes.
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You will then see the Customize My Tags task pane.

Let’s take a look at what you can do with the various tags.

If you want to… Then…

Modify an existing tag Click the Modify button

Change a tag’s position in the menu Select the tag and use the up and down arrows at
the bottom of the pane

Remove a tag Select the tag and click Remove

Add a tag Click the Add button
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Using Templates for Meeting Minutes

Templates allow you to create custom layouts for your Meeting Minutes notes. In the example notebook
provided we have created OneNote templates of the included Meeting Minutes styles (action, informal, formal)
for you. The section below will help you understand how to create your own templates or change the ones that
have been provided in the example notebook to best suit your minute-taking needs.

Opening a Template

The Template task pane is opened from the Format menu.

Once you have found the template you would like to use, click the template link, and OneNote will add the new
page to your notebook.

Please note that if a template has been designated as the default template for a section, this template is used
automatically when you add a new page. That has been done in the provided example notebook in the meeting
Minutes sections.

Using a Template

When you create a note using a template, the structure of the note is already in place; all you have to do is enter
the text.

You can edit notes created from templates the same way you would other notes.

Setting the Default Template

If you find a template that you want to use for an entire notebook or section, you can set the template as the
default template. That way, you can click New Page, and the template will be inserted instead of a blank page.

To set the default template, use the menu at the bottom of the Templates task pane. You will see templates that
are provided by OneNote and templates that were added to the notebook (e.g. the provided meeting minutes
templates or your own custom templates):
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Saving the Current Page as a Template

In the Templates task pane is a command that will allow you to save any page you create as templates:

Once you click the command, enter the template name, and set the template as a default template if you wish:
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A Tour of the Minute-Taker’s Example Notebook

Today’s Meetings
For each day that you have a meeting scheduled in the future (e.g. the coming week) create a page and title it
with the date of the planned meeting. You can add new pages to this section as you schedule new meetings and
can archive the pages whose dates have passed (archive the meeting notes into the Meeting Notes Archive
section).

For each meeting on that day, place links to the OneNote pages where you have the minutes page, the agenda,
and any documents you may provide printouts of if you are a facilitator. This helps you quickly see what meetings
you have coming up and to add notes to these meetings to stay on top of things (especially valuable if you are a
facilitator).

You'll store the actual notes taken DURING the meeting (those that become Meeting Minutes) in the Meeting
Minutes template you choose to use (a new one is created for each meeting in the Meeting Minutes section you
use in this OneNote notebook). This section (Today’s Meetings) is just to help you stay organized.

Agendas
Each meeting you attend should have an agenda. As a Minute-Taker you may not have the responsibility to
provide the agenda, but you may if you have another role you fulfill like the meeting chair or facilitator.
Regardless of where the Agenda comes from, when you have a copy of it, place it in this section and link to it
from your Today’s Meetings page and also on the Meeting Minutes page for this meeting.

You can file these away in the Meeting Notes Archive once you have used them in the meeting. Before you do
that you should check to see if the agenda is to be formally included in the Meeting Minutes.

Form and Checklists
As discussed in this course, you may be responsible to obtain signed agreements (position contracts) and to use
other documents (e.g. standard forms for recording motions and voting) on a regular basis. If this is the case you
should store these in this section, one per page.

As you generate standard forms you use for each meeting (e.g. formal templates for recording votes, signed
agreements, position agreements, etc) store them here so you can easily find one, customize it, and print or e-
mail it for use. When you require a paper or form, simply copy the page it is on and work on the copy filling in
what detail you require before printing it for distribution during the meeting.

Meeting Minutes
Choose a style of minute-taking that is right for your organization or develop your own. Templates included are:
Action, Informal, and Formal. Once you have chosen a style works for your organization or have created your own
you can delete the unused Meeting Minutes sections.

When you add a new page to this section, it will use the Default Template for the section (you can create your
own template or use the templates provided). Create a new page for each meeting you record minutes for.

Take your notes for the meeting below the actual Meeting Minutes template area of the page. Once you have
recorded the minutes as notes during the meeting, return to the top of the template and fill in the sections,
summarizing your notes.
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Send out the meeting minutes to the meeting participants (e.g. using e-mail) and place a copy (either printed or
electronic) in the Meeting Minutes book.

Once all revisions of the Meeting Minutes are complete you can move the minutes to the Meeting Notes Archive
section, if you want to (this helps keep your day to day minute-taking section organized and clean).

Distributing Meeting Minutes…
Once you have compiled your meeting minutes into the meeting minutes format you have decided to use and are
ready to distribute them to the meeting attendees, you have a number of ways you can distribute the notes:

…As an e-mail
You can copy the OneNote meeting notes into a Microsoft Outlook e-mail message (you can also use other e-mail
programs, especially those that let you compose HTML e-mail). You would do this by selecting the text of your
completed meeting minutes in OneNote, copy them (either using the Edit menu’s copy function or pressing Ctrl +
C), and pasting the minutes into an e-mail message.

When pasting the notes into Outlook be sure to watch for the clipboard icon ( ) and use it to select “Keep
source formatting” to make sure your notes look as close as possible to the original after you paste them.

…As a Word document
Microsoft Word documents can be distributed to the meeting attendees by sharing them using a web-based
portal like Microsoft SharePoint, saving them in a shared document repository (e.g. a shared folder in Windows),
or by e-mail the document as an e-mail attachment.  You can save the notes to a Word document by creating a
new Word document and copying the meeting minutes as you would for the Outlook message, above.

…As a shared OneNote notebook
Another option to share your meeting minutes is to store the OneNote notebook in a directory that the meeting
attendees have access to. In this way they could read the meeting minutes directly from your notebook. Only the
Minute-Taker should actually edit the notebook, though.

Once you have sent out the meeting minutes some attendees might have changes they would like to make to the
minutes. These changes should be gathered up, made, and a new version of the minutes sent out until everyone
agrees on the Minutes. At that point the Minutes should be archived in a permanent meeting minutes binder (or
similar electronic document).  If you need to store a printed copy, you can print directly from OneNote as you
would from any other Microsoft Office 2007 program.

Meeting Notes Archives
Once you have formally completed the process of recording meeting minutes, distributing them, and finishing
any changes made to them (usually at this point then minutes are recorded in an official Meeting Minutes binder
or electronic file), you can copy the pages to the Meeting Minutes Archive section from the other OneNote
sections to keep those sections clean and organized.

Archiving pages is a good idea (as opposed to deleting them) for two reasons:
 It is very easy to search in OneNote and so you can quickly refer back to past agendas and meeting

minutes even during a fast paced meeting if there is a question about something that happened before.
 Even if you have printed the meeting minutes or stored them in another electronic document format, it

never hurts to have an additional copy backed up in the Meeting Minutes Archive section of your
notebook.
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Techniques for Preparing Minutes

Top Techniques

While formal and informal meetings are conducted differently, and their minutes appear in different formats,
your job remains the same: to prepare an accurate account of the decisions and actions at a meeting.

To be a good Minute-Taker, you should:
 Understand company jargon
 Have background knowledge of the topics being discussed
 Know meeting participants or at least the spelling of their names
 Be familiar with past minutes
 Have good communication skills

Before the Meeting
Using OneNote’s tag functionality you can very quickly create and use a checklist. A very simple way to make sure
you are prepared for every meeting is to create a checklist in the Forms and Checklists section of the example
workbook and to print this checklist before each meeting, using it to ensure that you have done everything you
need to do before the meeting. As you continue to be a Minute-Taker you may want to use and customize the
following list to your unique circumstances.

Here is a checklist of things to ask before the meeting:
 Are you taking notes for someone else to transcribe or will you do it yourself?
 Are there previous minutes to examine?
 When are you expected to have the first draft prepared?
 What is the purpose of the meeting?
 Are you permitted to voice your own comments in the meeting or is your function simply to take notes?
 Will you be expected to have certain information on hand?
 What is the parliamentary authority used by the organization? How familiar should you be with it?
 Has an agenda been sent out to all the participants?
 Are you supposed to call the participants and remind them of the meeting?
 Are you responsible for booking the room and room setup?

At the meeting, if room setup is part of your job, try to arrive early to ensure everything has been prepared.
Some things you will want to prepare for include:

Seating
You as Minute-Taker should sit on the left hand side of the chair. The position to the immediate right is reserved
for special guests. The Minute-Taker should be able to see all the members. At some more formal meetings the
seating location of each meeting participant is important and pre-determined. If this is the case for a meeting you
are attending as a facilitator you should consider creating a seating plan (this may or may not be appropriate for



Office Administration / Office Skills

24| 2 4

you to do depending on your role).

Using OneNote it is very easy to quickly draw simple diagrams using the Drawing Tools toolbar. It allows you to
draw simple shapes like a rectangle representing a boardroom table, for example. You can quickly prepare a
seating chart in OneNote (you might want to do this on a page in the Today’s Meetings section) with a drawing of
the table and people’s names in the places where they are to sit. This can be printed and placed on the table as a
reference for meeting participants to use as they arrive.

Reading the minutes
If minutes are distributed ahead of time, they are not read aloud. However, at a general meeting where the
entire membership is invited to attend, it is common practice to read the minutes aloud. The Minute-Taker
usually reads the minutes in this case. If this is the case, have them unofficially approved by the executive group
ahead of time so you don’t have to worry about mistakes. You should also practice so you can read smoothly.

Corrections
Make sure you have a system for noting corrections to past minutes.

Computer systems need power!
If you are using OneNote to record minutes, make sure you have all the equipment necessary, including access to
an electrical outlet to keep your computer working correctly during the meeting. Although battery life is
improving all the time for laptops it is often not possible to get through a longer meeting without “plugging in”.

After the Meeting
If you don’t have time to prepare the minutes immediately after a meeting, at least reread your notes to ensure
they are sufficiently detailed so you can interpret them later.

According to memory studies conducted at the University of Minnesota, immediately after you listen to
somebody else talk you can only recall 50% of what was heard. After a week, this percentage drops to about 10%.
As Minute-Taker, you can’t afford to depend on your memory to recall important decisions!

Writing Minutes

Rough Draft
Your drafts should be labeled “Rough Draft” or written in an area of the OneNote template clearly designated as
a meeting notes area (in the included templates the formal report template is at the top, with meeting notes and
other draft copy placed below it). Be sure that the ideas you want to express are clear in your mind before you
begin to write.

In formal and semiformal minutes, always write in complete sentences using the past tense and the third person.
Never use abbreviations; type a person’s name in full. In action minutes, point form is acceptable.

In formal minutes, words such as “Committee,” “Board,” “Department,” or “Division” are capitalized, as well as
titles: “Secretary” and “President.” In informal minutes, these words are not capitalized unless they are
accompanied by a specific name. For example, in “the committee wishes…” use lowercase “c.” However, in “the
Education Committee wishes…” use capitals.

Use a straightforward narrative style and simple words. If the group is concerned only that the minutes be
intelligible to them, you can be brief in your comments. If the minutes are a means of communicating with
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others, then your summaries should be in essay style.

Headings or subheadings should not be left dangling at the bottom of a page; they should be followed by at least
two lines of text or moved to the next page.

Circulate the rough draft to as few people as possible or it will take forever to get the minutes written as
everyone will have his or her own version of what occurred.

Use subheadings for individual topics in the body of the minutes. Each item on the agenda can become a
separate heading.

Double check all figures, dates, and spelling of names.

Always keep your notes of the meeting until the minutes have been formally approved by the group. Once the
minutes have been formally approved, they are accepted by the group as truth and your notes are no longer
required.

Please see the section above for printing and e-mail information.

Final Draft
As minutes are normally filed in binders, use the bound manuscript format – 1.5 inches on the left margin and 1
inch for the right, top, and bottom if you are transferring your final minutes to Microsoft Word for printing (you
can also set these print preferences in OneNote for printing but it is not as good as Word for this final copy).

The heading lines should begin 1 inch from the top of the paper and each heading line should be centered. The
words can be typed in uppercase and lowercase letters or in capitals, depending on the organization’s office
style.

If the minutes are brief, double space the body and triple space between items. If they are long, single space
them with a double space between paragraphs. Indent paragraphs ten spaces unless you are using subheads. (If
you are, it is not necessary to indent.) Place the subhead directly above each paragraph.

Use bold face for subheads and to highlight dates and names.

The final copy of the minutes should be designated as such and distributed to the meeting attendees as part of
this last step.
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Editing Minutes

Spelling
People are either good or bad spellers. Most of us have a few words that we regularly forget how to spell.
However, that doesn't mean we can't produce letters, memos, and reports that are word perfect.

Here are some tips for making your documents perfect:
 Use a dictionary. It doesn’t matter which form you use, but it is important that you be consistent.
 Use spell check in OneNote, but don’t rely on it totally. In the case of the English language, make sure

you have selected the proper language type: English (US) or English (UK)
 Use an online information service or telephone book to check spelling of names and addresses.

However, there are sometimes errors in telephone directories too. Ideally, you will have some type of e-
mail communication from the meeting participants and possibly will have documents mentioning the
other names recorded in the minutes. Use these sources to verify all names, places, and technical terms
are spelled correctly.

 Proofread your work, and when possible have someone else proofread your work.
 Learn some little tricks to help you remember words that you use frequently but still spell incorrectly,

like, “i before e, except after c.”

Make up a list of your most common spelling errors and learn how to spell those words correctly. Keep that list
posted so you can refer to it when you need to.

Proofreading
Proofreading carelessly can spoil a writer's best efforts. Proofreading is classic evidence that writing looks
different to the writer and to the reader.

To the writer, typographical or spelling errors don't mean all that much. So what if your finger slipped, or you
always put two t's in "commitment"? Well for the reader, an unfixed typo can transform the writer from a smart
guy into a careless writer in an instant.

It is impossible to read about "fist class work" or "shot meetings" without breaking up. It may be unfair that
proofreading matters so much, but it does. If you can put yourself in the reader's position, you'll proofread
obsessively, gripped by the fear that a mistake will turn you into a laughingstock!

Proofreading errors is different from looking for punctuation or spelling or usage problems, and you fix them
differently.

Punctuation, spelling, and usage are knowledge problems, and you fix them by learning. Proofreading problems
are usually a matter of seeing, and you fix them by learning to look.

Ironically, the better you read, the worse you'll proofread, unless you consciously are aware of what you are
doing. Good readers and fast readers guess what the words are, and they just check in now and again to see if
they are right. The more they can guess, the less they have to look and the faster and better they read.

To be a good proofreader, you have to go back to being a child again, looking at every word as it comes along.
Here are some principles to guide you:

 Ignore content. As soon as you start paying attention to what the text is saying, you'll start assuming and
stop looking.
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 Assume there's at least one typo.
 Forget what you meant. Read the minutes as though you never saw it before.
 Read backwards. This destroys comprehension, and your eyes can't trick you as easily. You might be

surprised how many more typos you can pick up using this method!
 Don't try to do something else when you proofread. Stop tinkering with the thing and look for errors.
 Take your time. When you hurry, you guess and skim, and that usually doesn't work.
 Proofread a second time, paying attention to content. This is where you find those things spell check

and reading backwards did not catch, such as, “The little cap pulls off it you put enough effort into it.”
 Read it out loud. It is more difficult, but still not impossible, for your eyes to skip over errors when you

read aloud.
 Try to have someone else proofread your work, particularly if the document is important or going public.
 Make proofreading a game. Score points for yourself when you find an error!

Taking Minutes in an Interactive Meeting

The traditional style of meetings discussed so far is not particularly suited to informal problem solving,
collaboration, or for working out complex, interdependent issues. Nowadays, progressive organizations are
cutting meeting time with interactive meetings. Interactive meetings can be considered a mix of the traditional
meeting, brainstorming, and troubleshooting and take to heart the old saying “bringing people to the table.”

In conventional meetings, the chair normally has the most authority. The chair controls how the meeting
proceeds, talks more than anyone else, and is responsible for the final decisions. This can affect group
participation and morale and can result in poor decision making.

The Role of the Facilitator
In the interaction-style meeting, the chair separates procedural and decision-making responsibilities and appoints
someone to handle a new role: that of the facilitator. This enables the chair to sit and listen fully to the opinions
of the group.

The facilitator’s job is to accomplish a specific set of tasks. The facilitator must solicit opinions from the entire
group, ensure that everyone feels comfortable with the process, and keep the meeting on target.

The facilitator is assisted by the recorder, who ensures that all the members’ main points are written on large
sheets of paper taped to the wall in front of the group. In this way, everyone has a clear and immediate
understanding of what is being said and can see that all statements are accurate. All ideas are considered to
come collectively from the group, not from individuals, so the names of the originators of suggestions are not
recorded.

Both the facilitator and the recorder must remain neutral and refrain from voicing their opinions or editorializing.
If either one feels the need to make a personal statement, he or she must ask the group’s permission to
temporarily step out of the assigned role.

An ideal situation would have all the members of the group taking turns to act as facilitator and recorder. In fact,
the facilitator and recorder may even be invited from an outside department or group.
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Interactive meetings have the potential to be highly creative and productive. Members feel less intimidated and
have equal opportunity to participate in brainstorming and problem-solving sessions. They leave feeling heard,
validated, and energized. They have specific tasks to accomplish.

Taking Minutes at an Interactive Meeting
If you are appointed recorder at an interaction meeting, remember that your role is always to support the
facilitator and the group.

As a recorder, you must have:
 Good listening skills.
 Legible hand writing.
 An understanding of the group’s jargon.
 Confidence to ask the group to slow down if you fall behind in the recording.
 A nonjudgmental expression

It is important that you, as recorder, not put words in the mouth of a slow-thinking participant. Be quiet. Talk as
little as possible. Defer your questions to the facilitator. You are his or her teammate and support person.

When listing the group’s comments, use as much space as you would like in OneNote – whitespace often makes
for more easily understandable notes. Don’t worry about your spelling. You can use abbreviations, highlight key
words, or use arrows (created with the drawing tools). Use the highlighting tool to highlight ideas or place a
custom OneNote tag next to them to denote them as important. Get the members to restate any points you have
missed or misrepresented. The meeting members share the responsibility for accurate recording.

As discussed earlier in this book, you can create audio recordings directly in OneNote if you want to be 100% sure
you have accurately recorded what was said. In some organizations this is the norm as then there can be no
question of what was said and by whom.

It is very easy to store images and other electronic media in OneNote so once a meeting is concluded (or during
the meeting prior to erasing a whiteboard, for example) take digital photos of the various whiteboards and other
presentation aids that were used by attendees so that these can be stored in OneNote along with other meeting
minutes notes.

The Minute Book

Official copies of approved minutes are kept by the recorder in chronological order, usually in a three-ring binder
set up for that purpose, or in an organized, electronic format. The cover page may indicate the period the minute
book covers, such as, “The minutes of the Birdwatchers Society, from January 1, 2000 to December 31, 2002.”

You can use OneNote to organize your minutes and keep your own final copy but you will still need to comply
with your organizations best practices in terms of the Minute Book.

The Minute-Taker normally has custody of the book, minutes, and all official documents. However, every
member has the right to inspect the minutes, and certain minutes can be turned over to a committee if they
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need them to perform their duties. The Minute-Taker is also responsible for storing committee reports and
documents submitted at meetings. Before filing this material note on the covers the dates they were received
and state any further action that was taken.

An index is an alphabetical listing of all the main items discussed at meetings. Along with the topic, list the date it
was discussed and the page number where the information can be found in the minutes. Indexing the minutes
will take a few minutes but it will go a long way toward building your professional image. As Minute-Taker you
are also the group historian.

Maintaining an archive of Meeting Minutes in OneNote makes it very easy to search the minutes and view them
in a number of other ways. Under the View menu there are two menu options that can be used very effectively
for this:

 Pages sorted by date – opens a sidebar showing all the pages sorted by the date they were created, or by
the title, or by the section they are in. You can use this sidebar and the various sorting/filtering options to
quickly find minutes, notes, or other material for a given dare in the past.

 All tagged notes – opens a sidebar showing all the tagged notes in a notebook and has similar
sorting/filtering options. This sidebar is very useful if you use OneNote tags to designate motions, action
items, etc. If you wanted to quickly find all the action items for a given committee over the course of a
month’s weekly meetings you could probably do so faster this way than by pulling up the meetings
minutes individually and reading through them, assuming you used tags to designate the action items.

Groups who don’t make a lot of motions may prefer to use a motions book rather than an index. The motions
book contains all the motions and amendments ever made by that group, with the dates they were made. If this
is the case for your organization, consider creating a Motions section in your notebook for tracking these motions
and using the same procedure you use to print minutes for inclusion in the Minutes Book to prepare your entries
in the Motions book.

The Minute-Taker should also have all the rules that the group use to govern itself by, such as the constitution
and bylaws and procedures.

These should be combined into one book that the Minute-Taker brings to each meeting. These should be
included in your OneNote notebook in a Section dedicated to them. This will make these easily searchable if
there are questions about the rules or regulations during a meeting.

Further Reading:


